Welcome to the Website Blueprint for LAC Courses!
(Version 2.0, 1/2007)

This document will give you basic instructions on using Dreamweaver MX for PCs to create the website for your LAC section.  If you have any questions or need more help, feel free to contact Tanya Kinsella at 962-1602 or tekinsel@email.unc.edu.

Unfortunately, the UNC LAC Program cannot provide assistance for Mac-users.  Please contact Tanya at 962-1602 or tekinsel@email.unc.edu for other sources of technical support on campus.

Before you Begin

1)  If you do not already have Dreamweaver MX installed on your PC, contact Tanya at 962-1602 or tekinsel@email.unc.edu to obtain an educational copy.

2)  Make sure you have access to server space that can house your website.  You can use your personal webspace at www.unc.edu or server space belonging to the department offering the course attached to your LAC section (see http://help.unc.edu/?id=108 for more information on both options).
Once you’ve located appropriate server space, you will need to find out your FTP Host and Host Directory in order to set up your webpage.  Your FTP Host will most likely be “isis.unc.edu” but it is possible that yours is different.  If you are using personal server space, your Host Directory will probably contain your onyen in some way (ex: “/afs/isis.unc.edu/home/o/n/onyen/public_html/”); if you’ve been given access to department server space, your Host Directory will probably contain the name of the department (ex: “/afs/isis/depts/deptname/public_html/”).
3)  Preview the Blueprint online at http://www.unc.edu/nrc/lac/important_docs.htm to familiarize yourself with the format.
Downloading the Blueprint
The first thing you need to do is download all the blueprint files online.  Create a folder on your hard-drive to house the files, then go to http://www.unc.edu/nrc/lac/important_docs.htm to download the zip file containing the Blueprint.
The zip file contains both individual files and folders.  Make sure to save them as-is into your designated folder—for now, do not rename or move the files around or Dreamweaver will have difficulty locating them.
Setting up a New Site in Dreamweaver
After you have saved the Blueprint on your hard-drive, you can set up your new webpage using Dreamweaver.  The following instructions provide an easy way of doing so.  
In Dreamweaver, click on the “Site” tab on the menu bar at the top of the screen, then select “Manage Sites” (see below).  [You can also select the “Files” bar in the expanded panels on the right side of the screen, then select “Manage Sites” in the dropdown menu.]  
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A small “Manage Sites” dialogue box will pop up (see below).  
Click on the “New” button.  A small dropdown menu will appear; select “Site.”
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Now the larger “Site Definition” dialogue box will appear:

Select the “Advanced” tab at the top left of this box, then click on “Local Info” in the category menu to the left.  You will need to supply the following information:
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Site Name.  Give your site any title you wish. (ex: “INTS 210 Spanish LAC Fall 2006.”)
· Local Root Folder.  Dreamweaver needs to know where your Blueprint files are located on your hard-drive.  You can either type in the folder location or click on the folder icon to the right of the box to browse and find it.
· Default Images Folder.  All the images of the Blueprint are located in one of the folders you downloaded, called “images.”  Click on the file folder icon to browse and show Dreamweaver where it is located.  

· HTTP Address.  Type in the web address where your website can be found on the internet (ex: http://www.unc.edu/courses/2006spring/ints/077/615).
· Cache.  Click to make a checkmark appear in the box next to “Enable Cache.”
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  In this dialog box, enter the following:
· Access: Select “FTP” in the dropdown menu.
· FTP host: Type in the address of the FTP host that will store your webpage. (This will probably be “isis.unc.edu”, but depending on the server you are using, your FTP Host may be different.)
· Host Directory:  Type in the location of your new webpage on the FTP host.  If you are using personal server space, your Host Directory will usually contain your onyen in some way (ex: “/afs/isis.unc.edu/home/o/n/onyen/public_html/”); if you’ve been given access to department server space, your Host Directory will probably contain the name of the department (ex: “/afs/isis/depts/deptname/public_html/”).

· Login:  Type in your Onyen.
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· Password: Type your Onyen password and click to make a check appear in the “Save” box.  After you do this, click on the “Test” button to make sure you do indeed have access to the FTP host.
You do not need to check any of the other boxes in this dialog box.  Click the “OK” button.
The “Manage Sites” box will appear again.  Click “Done” at the bottom left of the box. 
You’re now finished defining your site.  
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Editing the Index Page (.htm document)
Once your site has been defined, you can begin editing the index page of the Blueprint to create your course website.
In Dreamweaver, click on the “Files” bar in the expanded panels on the far right-hand side of the screen (see illustration).  The dropdown menu under the “Files” tab should display the folder you created on your hard-drive that houses the Blueprint files; this is called the “Local View.”  
Later, when you upload your customized files to the server, you will use the “Remote View”—this will be explained in the section “Uploading Your Webpage Files.”  For now, it is important to make sure you are in the “Local View” before you begin editing.
Double-click to open “index.htm.”  Your screen should now look like this:
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[If html code appears instead of, or in addition to, the template preview as it appears above, you can select the “Design” view under the “index.htm” tab on the upper left of your screen to view only the page layout.]
Please note that on this index page, you will only be able to edit the information contained within the blue box labeled with the “Content” Tab.  The header, footer, and background image are established by a template and cannot be altered.
1.  Changing the Course Heading 
Centered at the top of the “Content” box you should see the words “LAC 123: Course Title.”  To change this heading, simply highlight the words “LAC 123: Course Title” and type in the correct information for your LAC section (ex: “INTS 210 French LAC, Fall 2006”). 
2.  Changing the Table of Anchors
Directly under the course title, you will see a small table containing six boxes of blue text.  Each of these boxes is anchored to a different section of the index page, so when a visitor to your webpage clicks on “Assignments,” the screen will jump down to the “Assignments” section of the page to display a list of the course texts.  
Before you proceed to edit the table of anchors, you need to decide what information you’d like to include on your index page, and how you will organize that information into separate sections.  Of course, you’re welcome to use the six preset anchors exactly as-is, in which case you can skip down to step “3.  Changing the Sections of Information.”  
2a.  Editing the Text in the Anchor Boxes

If you’d like to edit the text contained in an anchor box (to reflect the language used in your LAC section, for instance) highlight the words you’d like to change and simply replace it with your preferred text.  
2b.  Deleting an Anchor Box
If you wish to have less than six anchored sections on your page, you will need to delete the boxes you do not plan to use.  To delete an anchor box, click your cursor inside the box you want to get rid of.  In the menu at the top of the Dreamweaver window, select “Modify,” then “Table,” and then “Delete Column.”  The box should disappear.
2c.  Adding an Anchor Box
Increasing the number of anchor boxes in the table is a bit more complicated.  Begin by clicking your cursor inside the box just to the right of where you would like the new box to be located.  Then select the “Modify” menu at the top of the Dreamweaver window, followed by “Table” and “Insert Column.” Your cursor should now appear inside the empty new box and you can type your desired text.  
To make this new text match the style of the other boxes, you will need to edit the options in the “Properties” panel, which should appear automatically at the bottom of your screen when your cursor is inside the new anchor box you just created (see below).  The panel may, however, appear minimized as a small bar labeled “Properties”; if so, click on the bar to maximize the panel so that it appears as illustrated: 
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Highlight the text you just typed in the new box and select “Heading 5” in the “Format” dropdown menu of the “Properties” panel.  Click on the correct text alignment button to center your text within its box.  To make your text color Carolina Blue, type “#00ADEF” in the empty space just to the left of the bullet button.  
To make this anchor box function properly, you will also need to create a new anchor to which can link the new box.  See step “3c.  Adding a New Section” for further instructions. 
3.  Changing the Sections of Information
3a.  Editing the Sections
To change each section of the body of the index page, simply highlight the existing text and replace it with the text you wish.  

If you want to change the name of the first section, for instance, double-click the word “Overview” and replace it with your desired section title (remember that the title of this section should match the text contained in the leftmost box of the menu of anchors, so make sure to edit the menu of anchors if necessary).  To alter the paragraph of information that follows the section title, you can highlight the entire paragraph and just type in the text you prefer.  
If you happen to delete the formatting of either a section title or a paragraph, don’t worry.  At the bottom of the screen, click on the bar labeled “Properties” to bring up the panel below:
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Next to the “Format” option, you will see a dropdown menu.  To return the section title to its original formatting, double-click on it and select “Heading 3” (the “Style” should appear as “None”).  To restore a paragraph’s formatting, highlight it and select “Paragraph” and ”None.” Notice that this panel also allows you to change the text alignment (left-justify, center, right-justify, full justify) and color if you wish.

3b.  Deleting a Section
When you edited the table of anchors, you may have decided to eliminate one or more of the sections of information in the body of the index page.  If so, you will need to delete those sections from the page entirely.  Begin by deleting the unwanted anchor, which appears as a yellow image to the left of the section title you wish to eliminate (see below), then press the “delete” key.  To delete the section title and the paragraph which follows it, simply highlight the text and then press the “delete” key.  
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3c.  Adding a New Section of Information

If you decided to add an additional box to the table of anchors, you will need to add a new section of information to the body of the index page, and then create a new anchor which corresponds to the correct anchor box.
Let’s say, for instance, that you added a new box to the table of anchors called “Quizzes,” and you need to add this new section to the index page between the “Assignments” section and the “Links” section.  To create space to house the new section, place your cursor at the very end of the last line of the “Assignments” section and hit the return key twice.  Then type the name of the new section: “Quizzes” and hit return once again.  To make this new section title match the formatting of the others, highlight the word “Quizzes” and then select “Heading 3” in the “Format” dropdown menu of the “Properties” panel.
To add a paragraph of information after the new section heading, place your cursor on the line below the “Quizzes” heading and type the text you wish to add.  If for some reason the formatting is not correct, bring up the “Properties” panel and select the “Paragraph” setting in the “Format” dropdown menu.  
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To create an anchor for this new section, place your cursor to the left of the “Quizzes” section heading.  Now select “Insert” on the menu bar at the top of the Dreamweaver window, then “Named Anchor.”  In the dialogue window that appears (see illustration), type in the name of your new anchor (ex: “quizzes”) and click “OK.”  A yellow anchor image should now appear to the left of the section title.
To make the “Quizzes” box you created in the table of anchors lead to this new anchor, scroll up to the table and double-click on the relevant box.  The “Properties” panel should appear at the bottom of the screen.  In the “Link” box on the right-hand side of this panel, type in a number sign followed by the name of the anchor you just created (ex: “#quizzes”), then hit return.  
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3d.  Adding Links to Other Websites
To add a link to an outside website (in the “Links” section, for instance, or in any other section of the index page), insert the text you want to contain the link, then highlight that text and type the web address (beginning with “http://”) in the “Link” box of the “Properties” panel at the bottom of the screen.  If you would like this link to open in a separate window, select the “_blank” option in the “Target” box of the “Properties” panel.
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3e.  Adding Links to Documents
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In the “Assignments” section (and perhaps also in the “Main Course Information” section), you will want to add links to documents (such as .doc or .pdf files).  First, you need to save a copy of the document within your webpage files on your hard-drive.  Then highlight the text on the page where you want to link to be located.  In the “Properties” panel at the bottom of the screen, click on the folder icon at the far-right of the panel, just to the right of the “Link” box, to browse and select the appropriate document.

3f.  Adding Images
If you’d like to add an image somewhere on the index page, you first need to save the image onto your hard-drive in the “images” folder of your webpage files.  Then place your cursor on the page where you would like the image to be located.  In the menu at the top of the Dreamweaver window, select “Insert” and then “Image.”  The following dialog box will appear: 
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Browse to locate the image you want to insert, then click “OK.”  

Incorporating images into your website can be quite complicated.  If you would like more information or assistance, contact Tanya.
3e.  Adding an Email Link
In the “Contact” section of the index page, don’t forget to insert a link to your email account, in addition to typing your correct email address in the contact section.  To do so, click on the “Properties” bar at the bottom of the screen to bring up the “Properties” panel and then highlight the text where the email link should be inserted.  In the “Link” box in the “Properties” panel, type “mailto:” followed by your email address, using no spaces (ex: mailto:onyen@email.unc.edu).
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4.  Changing the Page Title
The final step in editing your index page is to change the text which appears in the title bar, the blue strip that appears at the very top of the window when students access your page.  To alter this title, highlight the words “Untitled Document” in the gray bar under the “index.htm” tab at the top of your index page window.  

5.  Saving your Changes 

When you’re finished editing the index.htm page, don’t forget to save it!
Uploading your Webpage Files
When you’ve finished editing the index page, you’re ready to upload your webpage to the server.

In the “Files” panel on the right side of the Dreamweaver window, highlight the uppermost folder in the list of folders and files to select the entire site.  Then click on the blue up-facing arrow to upload the site folder and all its contents.
You can double-check to make sure that the folders were successfully uploaded by selecting “Remote View” in the dropdown list on the right side of the files panel.  This view will show the files and folders that now reside on the server.  
* It’s very important to make sure you switch back to the “Local View” before you edit any files. *
Now open your web browser and type in the appropriate web address of your LAC course website.  If you’ve followed these instructions correctly, your website should be complete and accessible online!  
After your LAC website has been uploaded and is functioning correctly, please let Tanya Kinsella (tekinsel@email.unc.edu) know its web address, so that she may link to it from the UNC LAC webpage.

Turning in Your Completed Webpage at the End of the Semester
Your TA contract requires you to turn in your completed LAC webpage files to Tanya Kinsella at the end of the semester, including the following:  
· Your LAC course page (the “index.htm” file)

· All course readings or assignments (.doc or .pdf files linked to the “index.htm” file)
· Any images you may have added to the images folder of your LAC course page 
As long as your webpage does not include many large files, you are welcome to email the files to Tanya at tekinsel@email.unc.edu.  If your email client limits the number of files you can include in a single email, you may have to send them in two or more emails.

If you prefer, you may save your webpage files to CD and either drop them off in person or mail them to Tanya via campus or U.S. Mail.
Helpful Resources 
http://cbt.unc.edu : Use your onyen to access Dreamweaver tutorials 
PAGE  
4

